Questions
Question 1 : Choose the correct answers:
1. Touch screen is one of …………….. units.
A) Input only

C) output only

B) Input and output

D) None of all mentioned

2. ………………… is one of the output units.
A) Printer

C) Keyboard

B) The mouth

D) Microphone

3. ………………… is the memory which keeps data temporarily.
A) RAM

C) ROM

B) Flash Memory

D) All mentioned

4. Three Kbytes is equal to…….. bytes.
A) 3 X 1024

C) 1024 X 1024 X 1024

B) 3 X 1000

D) nothing of what was mentioned

Question 2: Put ( ) or () :
1) Operating system must be installed on the computer to be able to operating the
rest kinds of different programs and applications

(

)

2) The user can prompt commands and instructions of the operating system
through command prompt

(

)

3) MAC OS X is one of the open source operating systems.

(

)

4) Android is an open source operating system.

(

)

5) The type of the file can be identified through its icon or extension

(

)
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6) The permanent delete in Trash can be restored again

(

)

7) The temporary deletion within the Recycle Bin can be restored again. (

)

8) Cut and paste of the folder means repeating it to get a spare copy either at the
same storage unit or at another.

(

9) Files can be saved by using (Shift + S).

)
(

)

10) Linking devices together within a computer network gives the possibility of
sharing the data only.
11) The Internet is considered a special type of wide area networks.

(

)

(

)

12) The wide range network uses different methods than that of the local network
to maintain connectivity.

(

)

13) To share folders, your device must be connected to the network to help other
users to reach it.

(

)

14) To share files in Windows Operating System, It is not necessary to be added in
a folder.

(

)

15) Specifying the user Everyone to share a folder in Windows Operating System
means allowing all users to share it .

(

)

16) The Computer icon is used to access the shared folders in Windows Operating
System

(

)

17) Sharing files in the Fedora Operating System is to be implemented through
allowing the network users to access a folder Document.

(

)

18) To make the process of sharing files accessible in Fedora Operating System, the
sharing setting must be set upon an Off position.
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(

)

19) On opening the GIMP program for the first time the program is shown in the
multi window-window mode

(

).

20) For more information about one of the tools click F5 from the keyboard
(

).

21) Use the "Selection" tool to draw the image freely

(

).

22) The "Pencil tool" is considered one of the selection tools

(

).

23) The "Ellipse" selection tool is used to select an oval shape of the image.

24) Use the Pencil tool to make a free hand selection.

(

).

(

)

25) The Clone tool used to mix the current color with the surrounding colors in
the space where the tool is moving.
26) One of the selection tools is the Blend tool.

(

)

(

)

27) The Smudge tool is used to copy part of the image in another place in the same
image layer, it is well known for modifying and reforming images.

(

)

28) The Eraser tool is used to delete a color space of a picture or an image.(

)

29) Transform Tools are used to change the form of an image through move, resize
or change dimensions.

(

)

30) Move Tool is used to move an image or image layers or selection or text.(

)

31) To move, press Alt + CTRL and continue pressing using the Move tool(

)

32) Rotate tool is used to crop an image.

(

)

33) Crop tool is used to rotate an image.

(

)

34) Scale tool is used to make horizontal or vertical flip of an image.

(

)
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35) Flip tool is used to make change an image dimensions [length, width]. (

)

36) A filter is used to help change the appearance of an image.

(

)

37) To use filter, from the “Filters” menu, select the suitable filter.

(

)

38) When we use „Filters”, a new layer is added or a new file is created. (

)

39) In the Vector Image, the quality and clarity of the picture change when
zooming in or out.

(

)

40) Copy Raster Image is characterized by a change in image quality and clarity
when enlarged or minimized.
41) There is only one color mode of the image

(

)

(

)

42) RGB mode fits very much in the case of display images and graphics through
the computer screen
43) RGB mode consists of the primary colors (red, green and black)

(

)

(

)

44) You can convert the image to the color Grayscale using the Grayscale
command.

(

)

45) You can convert the image from RGB mode to Grayscale mode where the
image loses its Colorimetric data

(

)

46) In order for other software to read the image file, the image must be exported
through the Save command from the File menu

(

)

47) The image can be converted from RGB mode to Grayscale mode

(

)

48) The large size storage area is from the Vector Image defects

(

)

49) When the active layers tab , it displays the information current active image.(

)

50) We can export a file in extension .gif or .jpg.

)
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(

51) To delete a layer click on the layer visibility icon.

(

)

52) To rename a layer, double click on the layer.

(

)

53) To merge all the layers into a single layer , from the Edit menu select Flatten
Image .

(

54) To add a new layer , click on the New layer icon

)

in the layers tab.(

)

Question 3: Complete the following:
1) …………. , …………. , …………. are examples of computers
2) …………. , …………. , …………. are computer system elements or components.
3) …………. , …………. , …………. are of the output units.
4) ……………………………….. is the unit of measuring the processor speed.
5) To delete the selection choose ...............................
6) The "Lasso" Free Selection tool is used to select .................
7) The "Magic wand" tool or "Fuzzy Selection" is used to select ...........
8) The " smart Scissors " selection tool is used to select . ............
Question 4 : Answer the following questions:
1) Why the permanent unit is called so?
……………………………………………………………………………………
…………………………………………………………………………………..
2) What do you mean by open source programs?
……………………………………………………………………………………
…………………………………………………………………………………..
3) Show the difference between: freeware – shareware
……………………………………………………………………………………
…………………………………………………………………………………..
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4) Define three functions of operating system?
……………………………………………………………………………………
…………………………………………………………………………………..
5) Show the most important advantage of (GUI) graphical user interface?
……………………………………………………………………………………
…………………………………………………………………………………..
6) What is the main function of self-test program?
……………………………………………………………………………………
…………………………………………………………………………………..
7) Mention the most important benefits of computer networks?
……………………………………………………………………………………
…………………………………………………………………………………..
8) The type of network differs according to the geographical area it occupies.
Mention two types of networks range?
……………………………………………………………………………………
…………………………………………………………………………………..
9) Using the Read/Write option may cause a problem to users when sharing
folders. Explain
……………………………………………………………………………………
…………………………………………………………………………………..
Question 5 :What is the difference between:
(1)

File and folder
……………………………………………………………………………………
…………………………………………………………………………………..
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(2)

Save and save as
……………………………………………………………………………………
…………………………………………………………………………………..

(3)

Delete and Delete from Trash
……………………………………………………………………………………
…………………………………………………………………………………..

Question 6 : Write the scientific term:
(1) Files belong to operating system and components connected to computer, never
play with it.

(……………………….)

(2) A collection of data which is stored in the storage units in different extension.
(……………………..)
Question 7: Complete the sentences using the words between brackets
(files - size - data - users - the name - research - devises)
1. One of the most important benefits of the network is centralizing ........ ....................
2. The local network is a limited network in the ........ ....................
3. Sharing ........ ....................is a process of spreading digitally stored information.
4. Searching for accessing required device on the network is to be through .... ...........
5. It is possible to other ........ ....................to access the files that you shared through
accessing your folder Public.
6. The term Sharing is written in the ... ..............dialog box to access the Sharing icon.

7

Question 8: Rearrange the following steps to share a folder in Windows Operating
System:
(

) Choose the user allowed to share the folder.

(

) Choose the option Specific people then a dialogue box File Sharing appears.

(

) click ADD to add this user to the list of users who are allowed to share.

(

) open the context menu of the folder to choose the command Share with.

(

) Press Share to complete sharing the folder

Question 9 :Complete the following
statements:
First: To create a new image the following
steps should be followed
1. Identify the dimensions of the new image.
2. .................................. .
3. ..................................
4. ..................................
5. ..................................
6. ....................................
Second: save command is used from the File menu, where the GIMP program offers
..........
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Question 10: Rearrange the following steps of using the Clone tool:
(

) stop the cursor at the beginning of the place required to be copied

(

) look at the picture to know the part required to be copied.

(

) move to the required place to add the copied version.

(

) do not stop pressing and pulling till you complete the copying.

(

) choose the Clone tool.

(

) press the "CTRL" key on the keyboard (the cursor shape changes to )

(

) click by pulling to create the copied version.

Question 11: Put the following steps in the correct order to use Scale tool:
(

) open an image file.

(

) Drag and pull at one corner to change the dimensions or from the dialog box.

(

) Press the tool on the image to show the dialog box to decide the image
dimensions.

(

) Press Enter from the keyboard after finishing the dimensions.

(

) Select the Scale Tool.

Question 12:
Complete the following phrases:
The following picture shows the "Layers" tab,
Explain what each number refers to:
1. ..............................
2. ..............................
3. ..............................
4. ..............................
5. ..............................
6. ..............................
7. ................... ...........
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Question 13: Order steps to export file with appropriate extension:
(

) From the File menu choose Export, select the appropriate extension of the file
and the file name.

(

) to merge all layers into a single layer, choose Flatten Image from the Image
menu.

(

) ensure that all layers are Visible.

Question 14 : Complete the following:
In the dialog box of the “Old photo”
properties, when select “Work on
Copy “, this means
..........................................................
..........................................................
..........................................................
..........................................................
..........................................................
..........................................................
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Question 15 Complete the following:
( Computer – Hardware – Main Memory – Kbyte – System Unit )
1) …………..………. From the basic elements of a computer system.
2) …………..………. is basic physical component of the computer.
3) …………..………. is an electronic device that has the ability to store, retrieve
and process data..
4) …………..………. from the most important of system unit components.
5) …………..………. = 1024 Byte
Question 16: Choose the correct answer:
1) Gigabyte ( GB ) = …………..……….
A) 1024 KB

B) 1024 MB

C) 1024 GB

2) …………..………. is an electronic device that has the ability to store , retrieve
and process data.
A) Computer

B) Mobile

C) Hardware

3) To convert Terabyte to Gigabyte …………..……….
A) times by *8

B) divide by / 8

C) times by *1024

4) …………..………. software is available for the general public to use and modify.
A) open source

B) closed source

C) Hardware

5) Measurement unit of processor speed is …………..……….
A) Byte

B) Bit

C) Hertz

6) To convert Byte to Bit …………..……….
A) times by *8

B) divide by / 8

C) divide by / 1024

7) …………..………. from the basic elements of a computer system.
A) Hardware

B) Software

C) All the previous

8) …………..………. is open source software.
A) Adobe reader

B) Photoshop
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C) All the previous

9) …………..………. is closed source software.
A) GIMP
10)

B) Hertz

C) Megahertz

B) Image

C) All the previous

…………..………. units used to store data and information

A) Output
14)

C) Computer

Forms of data are …………..……….

A) Text
13)

B) Designer

Megahertz is bigger than …………..……….

A) Gigahertz
12)

C) All the previous

Humanware …………..……….

A) Hardware
11)

B) Windows

B) Storage

C) ROM

User can give orders to the operating system by …………. Or the Interface

A) Operating System B) Command prompt
15)

Operating Systems are classified into ………….. and open source.

A) closed
16)

B) File name

C) Folder

B) Save

C) All the previous

To restore deleted files and folders click …………

A) File
19)

C) open

To save a file for the first time , select …………

A) Save As
18)

B) command prompt

…………..distinguishes the file type and often have three letters.

A) Extension
17)

C) hardware

B) Restore from Trash

C) Folder

You can search for a file in your computer by ……. Of the file or extension

A) File

B) name

C) Folder
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Question 17 : Complete the following:
( Folder – Ctrl + F – Move to Trash – File – Trash )
1) To save a file , click on the …………..………. menu.
2) Right click on the folder you want to delete , click on …………..……….
3) Folders can contains others …………..………. and files.
4) To restore deleted files and folders go to …………..……….
5) To display search bar press on …………..………. from the keyboard
Question 18 : Complete the following:
( Raster – Vector images – 256 – RGB - Grayscale )
1) The …………..………. color model is an additive color model in which red
, green and blue light are added together in various ways to reproduce a
broad array of colors.
2) Digital images are divided into Raster images and …………..……….
3) The storage space of the …………..………. image is large.
4) The color mode …………..………. up to 254 degrees normal gradation ranging
from black and even white.
5) The color mode Grayscale up to …………..………. degrees normal gradation
ranging from black and even white.
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Question 91 : Match:
A

B

1

A

Used to select an irregular part of the image.

2

B

Used to draw an rectangular shape

3

C

Used to fill the selection

4

D

Used to draw an oval shape

5

E

Used to select the specific area or distinctive color

Question 20 : Match:
A

B

1

A

Used to draw a clear way

2

B

To remove the color spaces of images or graphics

3

C

To copy a part of the image and paste it in another place

4

D

To enlarge the picture to see the details more clearly.

5

E

To move the image from place to another.
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Question 21 : Match:
A

B

1

A

Used to make a gradient

2

B

To change the image area (length and width)

3

C

To cut a part of the picture

4

D

To reflect an image

5

E

Used to freehand painting
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Answer
Question 1 : Choose the correct answers:
1. Touch screen is one of …………….. units.
A) Input only

C) output only

B) Input and output

D) None of all mentioned

2. ………………… is one of the output units.
A) Printer

C) Keyboard

B) The mouth

D) Microphone

3. ………………… is the memory which keeps data temporarily.
A) RAM

C) ROM

B) Flash Memory

D) All mentioned

4. Three Kbytes is equal to…….. bytes.
A) 3 X 1024

C) 1024 X 1024 X 1024

B) 3 X 1000

D) nothing of what was mentioned

Question 2: Put ( ) or () :
1) Operating system must be installed on the computer to be able to operating the
rest kinds of different programs and applications

(

)

2) The user can prompt commands and instructions of the operating system
through command prompt

(

)

3) MAC OS X is one of the open source operating systems.

(

)

4) Android is an open source operating system.

(

)

5) The type of the file can be identified through its icon or extension

(

)
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6) The permanent delete in Trash can be restored again

( )

7) The temporary deletion within the Recycle Bin can be restored again. ( 

)

8) Cut and paste of the folder means repeating it to get a spare copy either at the
same storage unit or at another.

(

9) Files can be saved by using (Shift + S).

(

)
)

10) Linking devices together within a computer network gives the possibility of
sharing the data only.
11) The Internet is considered a special type of wide area networks.

(

)

(

)

12) The wide range network uses different methods than that of the local network
to maintain connectivity.

(

)

13) To share folders, your device must be connected to the network to help other
users to reach it.

(

)

14) To share files in Windows Operating System, It is not necessary to be added in
a folder.

(

)

15) Specifying the user Everyone to share a folder in Windows Operating System
means allowing all users to share it .

(

)

16) The Computer icon is used to access the shared folders in Windows Operating
System

(

)

17) Sharing files in the Fedora Operating System is to be implemented through
allowing the network users to access a folder Document.

(

)

18) To make the process of sharing files accessible in Fedora Operating System, the
sharing setting must be set upon an Off position.
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(

)

19) On opening the GIMP program for the first time the program is shown in the
multi window-window mode

(

).

20) For more information about one of the tools click F5 from the keyboard
(

).

21) Use the "Selection" tool to draw the image freely

(

).

22) The "Pencil tool" is considered one of the selection tools

(

).

23) The "Ellipse" selection tool is used to select an oval shape of the image.

24) Use the Pencil tool to make a free hand selection.

(

).

(

)

25) The Clone tool used to mix the current color with the surrounding colors in
the space where the tool is moving.

(

26) One of the selection tools is the Blend tool.

)

( )

27) The Smudge tool is used to copy part of the image in another place in the same
image layer, it is well known for modifying and reforming images.

(

)

28) The Eraser tool is used to delete a color space of a picture or an image.(

)

29) Transform Tools are used to change the form of an image through move, resize
or change dimensions.

(

)

30) Move Tool is used to move an image or image layers or selection or text.( )
31) To move, press Alt + CTRL and continue pressing using the Move tool(

)

32) Rotate tool is used to crop an image.

(

)

33) Crop tool is used to rotate an image.

(

)
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34) Scale tool is used to make horizontal or vertical flip of an image.

(

)

35) Flip tool is used to make change an image dimensions [length, width]. (

)

36) A filter is used to help change the appearance of an image.

(

)

37) To use filter, from the “Filters” menu, select the suitable filter.

(

)

38) When we use „Filters”, a new layer is added or a new file is created. (

)

39) In the Vector Image, the quality and clarity of the picture change when
zooming in or out.

(

)

40) Copy Raster Image is characterized by a change in image quality and clarity
when enlarged or minimized.
41) There is only one color mode of the image

(

)

(

)

42) RGB mode fits very much in the case of display images and graphics through
the computer screen
43) RGB mode consists of the primary colors (red, green and black)

(

)

(

)

44) You can convert the image to the color Grayscale using the Grayscale
command.

(

)

45) You can convert the image from RGB mode to Grayscale mode where the
image loses its Colorimetric data

(

)

46) In order for other software to read the image file, the image must be exported
through the Save command from the File menu

(

)

47) The image Can be converted from RGB mode to Grayscale mode

(

)

48) The large size storage area is from the Vector Image defects

(

)
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49) When the active layers tab , it displays the information current active image.(

50) We can export a file in extension .gif or .jpg.

(

)

51) To delete a layer click on the layer visibility icon.

(

)

52) To rename a layer, double click on the layer.

(

)

)

53) To merge all the layers into a single layer , from the Edit menu select Flatten
Image .

(

54) To add a new layer , click on the New layer icon

)

in the layers tab.( )

Question 3: Complete the following:
1) Desktop , Laptop , smart devices are examples of computers
2) Hardware , software , Humanware , Data and Information are computer
system elements or components.
3) Printer , Monitor and Speaker are of the output units.
4) Hertz (Hz) is the unit of measuring the processor speed.
5) To delete the selection choose open select menu select None Command
6) The "Lasso" Free Selection tool is used to select an irregular part of the image
7) The "Magic wand" tool or "Fuzzy Selection" is used to select the color space
similar in an image
8) The " smart Scissors " selection tool is used to select . select the specific area or
distinctive color
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Question 4 : Answer the following questions:
1) Why the permanent unit is called so?
 Because when the computer turned off all data inside it remain as it is.
2) What do you mean by open source programs?


is a kind of free software. It is different from other software because
the source code is available to everyone.

3) Show the difference between: freeware – shareware
Freeware

Shareware

allow the possibility to take full advantage

trial program for limited

of them without a fee

time

4) Define three functions of operating system?
a. Control all devices connected with the computer ( printer , scanner
b. Manage the dealing between software and memory
c. Transferring data between different computer units and saved on storage
units
5) Show the most important advantage of (GUI) graphical user interface?
a. Graphical interface displays programs in the form of regular windows
b. Users can use dropdown menus and toolbars to do his tasks
c. Users can run more than one programs at the same time
6) What is the main function of self-test program?
Ensuring the safety of all units of the computer .
7) Mention the most important benefits of computer networks?
a. Sharing data and program between computer network
b. Sharing hardware
c. Centralizing data

21

8) The type of network differs according to the geographical area it occupies.
Mention two types of networks range?
a. LAN
b. WAN
9) Using the Read/Write option may cause a problem to users when sharing
folders. Explain
Allow other user to change the content of files or delete it
Question 5 :What is the difference between:
(1)

Folder and File
Folder

File

A place inside storage unit may contain files A group of data have a name , type
and sub folder

(2)

and extension

Save and save as
Save

Save As

 Used when a change happened to the
file to save the change in the same file
with the same name

(3)

 Used when a change happened
to the file name or save a new
extension

Delete and Delete from Trash
Delete

Delete from trash

Used to erase letter or word after selecting Used to delete file or folder from the
it

computer
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Question 6 : Write the scientific term:
(1) Files belong to operating system and components connected to computer, never
play with it.

(……Files System ….)

(2) A collection of data which is stored in the storage units in different extension.
(………File……………..)
Question 7: Complete the sentences using the words between brackets
(files - size - data - users - the name - research - devises)
1. One of the most important benefits of the network is centralizing Data .......
2. The local network is a limited network in the ........ Size
3. Sharing Files is a process of spreading digitally stored information.
4. Searching for accessing required device on the network is to be through name
5. It is possible to other user to access the files that you shared through accessing
your folder Public.
6. The term Sharing is written in the research dialog box to access the Sharing icon.
Question 8: rearrange the following steps to share a folder in Windows Operating
System:
(3

) Choose the user allowed to share the folder.

(2

) Choose the option Specific people then a dialogue box File Sharing appears.

(4

) click ADD to add this user to the list of users who are allowed to share.

(1

) open the context menu of the folder to choose the command Share with.

(5

) Press Share to complete sharing the folder
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Question 9 :Complete the following statements:
First: To create a new image the following steps should be followed
1) Identify the dimensions of the new image.
2) Click in the check box “Advanced Options”
.
3) X resolution / Y resolution
4) Color space
5) From Fill with Select Background color
6) Click OK

 Second: save command is used from
the File menu, where the GIMP
program offers save image files by this
extension XCF to save all information
about the image and it is useful in case of reopening of the picture and edited
the file.
Question 10: Rearrange the following steps of using the Clone tool:
(3

) stop the cursor at the beginning of the place required to be copied

(1

) look at the picture to know the part required to be copied.

(5

) move to the required place to add the copied version.

(7

) do not stop pressing and pulling till you complete the copying.

(2

) choose the Clone tool.

(4

) press the "CTRL" key on the keyboard (the cursor shape changes to )

(6

) click by pulling to create the copied version.
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Question 11: Put the following steps in the correct order to use Scale tool:
(1

) open an image file.

(4

) Drag and pull at one corner to change the dimensions or from the dialog
box.

(3

) Press the tool on the image to show the dialog box to decide the image
dimensions.

(5

) Press Enter from the keyboard after finishing the dimensions.

(2

) Select the Scale Tool.

Question 12:
Complete the following phrases:
The following picture shows the "Layers" tab,
Explain what each number refers to:
1) Layer Visibility
2) Layer Thumbnail
3) New Layer
4) Raise Layer
5) Lower Layer
6) Duplicate Layer
7) Delete Layer

25

Question 13: Order steps to export file with appropriate extension:
(3

) From the File menu choose Export, select the appropriate extension of the file
and the file name.

(

2 ) to merge all layers into a single layer, choose Flatten Image from the Image
menu.

(1

) ensure that all layers are Visible.

Question 14 : Complete the following:
In the dialog box of the “Old photo”
properties, when select “Work on Copy
“, this means applying Filter in the
other copy of the image

Question 15 Complete the following:
( Computer – Hardware – Main Memory – Kbyte – System Unit )
1) Hardware from the basic elements of a computer system.
2) System Unit is basic physical component of the computer.
3) Computer is an electronic device that has the ability to store, retrieve and
process data..
4) Main Memory from the most important of system unit components.
5) Kbyte = 1024 Byte
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Question 16: Choose the correct answer:
1) Gigabyte ( GB ) = …………..……….
A) 1024 KB

B) 1024 MB

C) 1024 GB

2) …………..………. is an electronic device that has the ability to store , retrieve
and process data.
A) Computer

B) Mobile

C) Hardware

3) To convert Terabyte to Gigabyte …………..……….
A) times by *8

B) divide by / 8

C) times by *1024

4) …………..………. software is available for the general public to use and modify.
A) open source

B) closed source

C) Hardware

5) Measurement unit of processor speed is …………..……….
A) Byte

B) Bit

C) Hertz

6) To convert Byte to Bit …………..……….
A) times by *8

B) divide by / 8

C) divide by / 1024

7) …………..………. from the basic elements of a computer system.
A) Hardware

B) Software

C) All the previous

8) …………..………. is open source software.
A) Adobe reader

B) Photoshop

C) None of the previous

9) …………..………. is closed source software.
A) GIMP
10)

B) Designer

C) Computer

Megahertz is bigger than …………..……….

A) Gigahertz
12)

C) All the previous

Humanware = …………..……….

A) Hardware
11)

B) Windows

B) Hertz

C) Megahertz

Forms of data are …………..……….

A) Text

B) Image

C) All the previous
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13)

…………..………. units used to store data and information

A) Output
14)

B) Storage

C) ROM

User can give orders to the operating system by …………. Or the Interface

A) Operating System B) Command prompt
15)

Operating Systems are classified into ………….. and open source.

A) closed
16)

B) File name

C) Folder

B) Save

C) All the previous

To restore deleted files and folders click …………

A) File
19)

C) open

To save a file for the first time , select …………

A) Save As
18)

B) command prompt

…………..distinguishes the file type and often have three letters.

A) Extension
17)

C) hardware

B) Restore from Trash

C) Folder

You can search for a file in your computer by ……. Of the file or extension

A) File

B) name

C) Folder

Question 17 : Complete the following:
( Folder – Ctrl + F – Move to Trash – File – Trash )
1) To save a file , click on the ………File …..………. menu.
2) Right click on the folder you want to delete , click on ……Move to Trash ….
3) Folders can contains others ……Folder .………. and files.
4) To restore deleted files and folders go to ……Trash .……….
5) To display search bar press on ……Ctrl + F …. from the keyboard
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Question 18 : Complete the following:
( Raster – Vector images – 256 – RGB - Grayscale )
1) The …………RGB ..………. color model is an additive color model in which red
, green and blue light are added together in various ways to reproduce a
broad array of colors.
2) Digital images are divided into Raster images and Vector images
3) The storage space of the …………Raster ..………. image is large.
4) The color mode ……Grayscale ………. up to 256 degrees normal gradation
ranging from black and even white.
5) The color mode Grayscale up to ………256 …..………. degrees normal
gradation ranging from black and even white.

Question 19 : Match:
A

B

1

A

Used to select an irregular part of the image.

2

B

Used to draw an rectangular shape

3

C

Used to fill the selection

4

D

Used to draw an oval shape

5

E

Used to select the specific area or distinctive color

(1,C)(2,D)(3,A)(4,E)(5,B)
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Question 20 : Match:
A

B

1

A

Used to draw a clear way

2

B

To remove the color spaces of images or graphics

3

C

To copy a part of the image and paste it in another place

4

D

To enlarge the picture to see the details more clearly.

5

E

To move the image from place to another.

(1,E)(2,C)(3,A)(4,B)(5,D)
Question 21 : Match:
A

B

1

A

Used to make a gradient

2

B

To change the image area (length and width)

3

C

To cut a part of the picture

4

D

To reflect an image

5

E

Used to freehand painting

(1,D)(2,E)(3,A)(4,B)(5,C)
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